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Introduction   

  
About Maintx    

Maintx is a Preventive Maintenance System that manages maintenance of real world 

appliances, resources, equipment and other assets of a Company. Wherever placed, 

whether on land or sea.   

The Maintenance Management System deals with many aspects in the operation of a 

company.   

  

Maintx is a very powerful tool. The application has taken its origin in a vision of real solutions 

for real customers.   

Our products aren't just made of a user interface environment with thousands lines of code. 

They are made out of ideas from years of customer relations and technical expertise.   

We have developed a practical understanding of industrial needs and the requirement 

needed most often is fulfilled by giving the solution in our application.  

With an effective preventive maintenance system embedded in maintenance management 

software, your maintenance department can be more efficient.   

The result is better service to keep your equipment and facilities operating.  

  

Key elements of its underlying system are:  
  

➢ Work order backlog controls,  

➢ Effective preventive maintenance,  

➢ Effective work history,  

➢ Controlled inventory with availability, and  ➢ Efficient manpower utilization.   

➢ Reduces the cost often associated with operating a maintenance software system.  

  

Maintx stands out among other maintenance software in that it takes very little time to use 

and implement. The Application is affordable and easy to use from small to mid-size 
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organizations that need to perform facility maintenance, equipment maintenance, plant 

maintenance, building maintenance and so on.  

  

Maintx is much more than just data collection software. It is a management system with 

efficient maintenance control procedures embedded throughout. Just by following the 

software guidelines, maintenance departments operate more efficiently. This results in 

better service to your primary operations. In turn, they can be more efficient and more 

productive. There is a definite link between maintenance performance and profitability.   

  

Preventive Maintenance - Helps protect your plant or equipment investment with an easily 

managed preventive maintenance work order system. It avoids untimely breakdowns that 

disrupt schedules and deliveries.  

  

Equipment information and history - tracks repair activity and costs for one item, a group, a 

department or all equipment.  

  

Open Work Orders - For planning, scheduling, coordination, backlog control and manpower 

utilization.  

  

Spare Parts Inventory - Insures the availability of spare parts. Avoids the downtime because 

to parts shortages. Helps control spare parts inventory levels and investment.  

  

The screens and reports satisfy the information needed for day-to-day operations as well as 

for management reporting.  

The mission of Maintx is to improve the internal operation and efficiency of your 

maintenance department, and provide a higher level of service and support to your primary 

operations. They generate your revenue stream. Maintx helps to insure that the revenue 

stream is not interrupted.  

  

Maintx was developed with an industrial engineering approach. It uses management 

techniques such as work simplification, productivity improvement, material control, cost 

control, engineering analysis and budgeting.  

  

Maintx was developed with a very high flexibility. The term flexibility is that the application 

can handle any number of equipment, equipment parts, departments etc. with the same 

performance and low budgeting. This Module is flexible and open, as the equipment list can 

be added, changed or deleted. You may check the samples before you enter your data.  

   

Our aim is to provide software solutions that are well thought-out, heavily tested and 

reasonably priced. We work closely with many of the largest software developers.  
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Applications products are used by individual corporations not just in the IT sector but also in 

factories, industries, insurance, service stations, and organizations such as corporation, 

finance, manufacturing and defense where reliability is crucial. This tool is of very high 

performance with excellent user-friendly environment, which leads the user to happily 

implement in their organization without any flaws.  

  

What is maintenance management system?  
In its simplest form, the maintenance management system automatically records the system 

status and reminds the system to take the preventive measures automatically before the 

equipment goes down. The maintenance management system is an integrated inventory 

control that ensures if necessary spare parts are available in stock at the appropriate time. 

The module allows you to update equipment, generate work orders, operate the inventory 

and generate purchase orders.   

  

Overview  
As the tool of preventive maintenance system has become common. It simplifies or nullifies 

the complicated measures that will result due to the absence of the Maintenance system in 

any firm. The maintenance system further increases the operational safety and reduces the 

costs, ensuring the high endurance of equipment.   

  

Maintx offers a user-friendly visual development environment that does not require 

knowledge of a language. It allows you to use a point-and-click interface to create and 

manage installation projects based on your business needs. This conserves your time while 

extending your flexibility. Much time need not be spent on the preventive measures as this 

tool takes care of everything and reminds you accordingly.  

  

The Advantages of Maintx  
  

* Lower maintenance cost   * Less inventory  

* No repetition of work    * Easier control  

* Easy access to inform    * Increased operating safety  

* Easier planning      * Long lifetime of equipment  

* Better use of manpower   * Better allotment of jobs  

  

  

COST SAVINGS  

Maintx has the flexibility to keep track of all the different types of equipment and projects 

you operate. Maintx reduces the time required to do the tedious repetitive activities 
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involved in tracking the type of activities/costs that are attributed to a particular piece of 

equipment.   

Maintx also produces various reports that provide critical management information, which is 

virtually impossible to acquire in a manual record-keeping environment.   

  

MAINTENANCE COST SAVINGS  

Users of Maintx have typically enjoyed savings on overall maintenance costs. These savings 

are achieved through increased management control and general productivity increases as 

well as throughout the application.  

  

MINIMIZE EQUIPMENT DOWN TIME  

Using the Maintx application will reduce your equipment down time by as much as possible. 

Since the program ensures the preventive maintenance activities, your greatest insurance 

against breakdown, are scheduled at the proper intervals.  

  

MINIMIZE EQUIPMENT FAILURES  

Despite appearances to the contrary, unexpected catastrophic equipment failure does not 

happen suddenly. It is often the result of neglect. In virtually all instances, the introduction 

of preventive maintenance scheduling reduces catastrophic equipment failures.  

  

CREDITS  

Maintx was developed using Soft Velocity Clarion 8, Microsoft SQL Server and Oracle. Special 

thanks to each and every Clarion programmer and Tester who worked together with us to 

develop the Maintx application by submitting bug reports and enhancement requests.  

  

  

SCHEMATICS  

  

http://maintx.net/en/support-material/schematics
http://maintx.net/en/support-material/schematics
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Getting Started  
  

System Requirements  
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COMPUTER / PROCESSOR  

➢ Pentium-compatible computer or later  

➢ 1Gb. RAM  

➢ 5 GB of free hard disk space available.  

  

OPERATING SYSTEM  

➢ Windows Vista  

➢ Windows 7 ➢ Windows 8  

➢ Windows 10  

  

DISPLAY  

➢ VGA   

➢ Higher-resolution video adapter like Super VGA or at least 256-color   

  

S/W REQUIREMENTS  

➢ Microsoft SQL Server   

  

PERIPHERALS   

➢ Mouse   

➢ Compatible pointing device  

➢ Supports printers  

  

NETWORK (OPTIONAL)  

➢ Microsoft TCP/IP  

  

    

User Interface        

                                                           

Function Keys & Shortcuts.  
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In Maintx, same as in other Windows based software, the mouse is always active. By clicking 

the menu bar in Maintx, opening up a selected window. By 

rightclicking on the mouse we get this small menu on the right  → 

with the choices of Insert, Change and Delete.  We can also use  

the  (insert),  (change) and  (delete) buttons on the 

screen.  

   

The scrollbar on our right can be used to navigate up and down through the window or 

we can use the page up and page down.  

The Arrow keys; up, down, left and right are used to navigate through the windows.   

The ”Home” button on the keyboard brings us to the first line on the first page. The “End” 

button on the keyboard takes us to the end of the page.  

  

  

FUNCTION KEYS  
Most function keys are standard.  

   

F1 key opens up „Help“ relating to the window we are on when we press it.  

F2 Opens the „Zone“ window. We can open it up wherever we are in Maintx.  

F3 Opens the „Departments“ window. We can use F3 wherever we are in Maintx.  

F5 (Or Right-Click) Shows list in option boxes.  

F6 Opens the „Equipment“ window.  

F7 Opens the „Company“ window.  

F8 Opens the „Employees“ window.  

F9 Shows all open windows, allows us to choose which window we want to work 

in.  

F11 Or "Cascade", all open windows are arranged like a card catalog.  

F12 Or "Tile", arranges all open windows on your screen in tile formation.  

CTRL - R Pressed together open up the "Task" window.   

CTRL – Y Pressed together open up the "Workbook" window.  

   

ALT - X Pressed together closes Maintx same as „Exit“ in the dropdown menu  
„File“.  

    

  

List box (in e-mails or files)  

In those windows containing the  button, we can click it to open this window --->  
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Here we can choose to send the chosen listbox straight to a printer, a File (PDF, Excel, 

Word...), or through E-mail and so on.  

  

  

Filtering in Listbox  
  

In “Listbox” we can easily organise the columns by name or number. We click the head of 

the column we want to (in this case Name). (Red oval) (+1)  

  

 
  

We can filter further by another column. We hold down the Ctrl button and click the next 

colomn head we want to filter by. (in this case Equipment) (yellow oval) (+2).  Now the tasks 
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are firstly listed alphabhetically by name and secondly by the equipment they are connected 

to.  

  

Furthermore by clicking the column head and writing a word like „Motor“ we filter out all 

the lines that don‘t contain the word Motor.   

  

  

Employees  
  

To add employees we go to the menu bar:   

  

  

Click „other“ and from the drop-down menu select „Employees“.  

For the same result we can press  „F8“  on our keyboard.  
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From this window we are able to add or edit „Employees“,  their „contact information“,  

„Rates“ and to „Assign Access“ to them.  To add a new employee we click the    button in 

the lower-left corner.  

  

Here we fill out the „Employees“ general information.    

Such as: Initials, „Social Security Number“ or „National Insurance Number“,  First and Last name 

and so on..  

For Telephone number we click the   button in the lower-right corner.  

Put the relevant information in and the same goes for the email.  
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Next we tick the box marked „Application User“ in the lower left corner and press  

and go to the “Preferences” tab.  

  

We choose a „login“  which will be the password when opening Maintx.  

We can decide which area Maintx opens on startup.  

My Jobs         Workbook   

Task table        Overview (tree)   

Stock Table       Quick Task  

Quick Task – No Equipment Parts  =  We can choose if we want to see equipment-parts or 

not, when in quick task mode.  

We can also decide what we want to allow the employee to see:  

• Allow Show All Departments  

• Allow Show All Equipment  

• Allow Show Whole Tree  

And  

• Allow Direct Delivery  

Always Show Planned = choose if we want to have planned sections visible all the time or 

not. If we select not to, we can still click the  button at the bottom of the 

screen to see planned sections.  

To set  „Rate“  we right click the „Rate“ box and choose a pre-existing rate or create a new 

one.   
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We create a new Rate by 

clicking   

To select the correct rate we 

simply double-click on it.  

Select a „Workbook“    

  we click the      button,    
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To assign access to the employee we select him again and go to the  „Access“  tab.  

  

departments we don´t want him to access by deselecting with the    button.  

Or   

select    the right workbook and press     

We can select all departments with the      button and then choose w hic h    
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We can press the    button and choose which ones he can see.  

  = Add  one                  = Add  all  

  = Detract  one            = Detract  all  

And the same goes for the „Stockroom“        

  

Finally we press     

  

  

How to register a new stockroom  
  

  

We start by going to (Spare Parts => Stockroom)  

We get a window with a list of all available stockrooms (if any exist).  
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Register Name, Place (location), to get a list of all employees to find the right supervisor for 

the stockroom we right click the box marked „Supervisor“. A list pops up and we select a  

supervisor and finally we click    

QUICK TASK  

  

To add a new stockroom we click    
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Quick Task is mainly used by employees whose job is to log in new malfunction tasks and not 

much else.  

  
When we use Quick Task, Maintx opens automatically up in the „tree“, letting us select the 

equipment we want the task to be on. Once we select an Equipment or Equipment-Part  

(double click or use Select) Maintx opens up a malfunction task and takes us straight to the 

„Description“  box.  
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.   

The job/task is ready and activated as Priority 1 job.  

  

Maintx returns to the „Tree“, ready for the next Malfunction task to be recorded.  

    

Security  
  

The Maintx security menu mainly deals in setting the access rights to the users and to the 

existing employees.   

The access rights depend upon persons to persons, as all the users and the employers 

cannot be given the same permission.   

The access right can only be set by the administrator or the supervisor and not by any 

person below this level.  

Therefor the system security plays an important role and deals in setting the access rights to 

either the users or the employers. The administrator can set the rights only after he gets 

logged in. This is done by entering the login and password in the Maintx screen. Once the 

login id and the password are provided, the authentication or the verification stage starts. At 

this stage, the password entered is verified with the stored password in the database (the 

password provided at the time of registering the application). Once the user is identified to 

be the genuine user, he is credited as a successful logger and allowed to access the 

application.  

We ins ert a description of the task and click  
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Let us have a look at how the administrator sets the access rights for the new users. This is 

done by opening the “Browse users” window by clicking the “Security” menu from “Files”. 

This window allows the administrator to include new user either as individual users or 

grouped users by clicking the “Insert” button. During the insertion process, the level of 

operation and accessing permissions for the new users can be set.  

  

   

Three different levels of operation are available   

➢ Supervisor   

➢ Operator   

➢ No access  

With the accessing permissions such as  

➢ No access  

➢ Full access  

For the Supervisor mode of operation, the access permission need not be explicitly 

defined, as the supervisor level is the top most priority with all the accessing rights 

implicitly defined.  
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For the operator mode of operation, the accessing permission should be defined by 

checking the “Initial access” option list.  

For the No access mode of operation, it is self-explanatory that this user is not allowed 

to enjoy the privilege of access rights.  

On the other hand, modification and deletion of the existing users could be done by 

selecting the change and delete buttons.   

A group is created by clicking the “User Groups” button and rights are allocated to the 

group. Individual users attached to the group, thereby they inherit the right of the 

group.  However overriding the group rights is always possible for any individual user. 

The authorization for the group can be provided at any one of the following levels 

discussed above  

  

For security reasons, only the supervisor or the administrator should have full access 

rights. The application is embedded with this security system so as to secure the 

information and to hide the information from the unauthorized usage.  
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In order to view access rights allotted to the users for the current working window, the 

shortcut key ctrl F8 is pressed. The ctrl F8 key opens the “Set Access Rights” window. 

One can fix the rights of the fields to either “Yes or No”, by double clicking on the 

respective record. From this window, the “Browse users” window could be called by 

clicking the “Users” button. Thus the “Browse users” window can either be accessed by 

clicking the “Security” menu or can be called from the “Set Access rights” window.   

So far the access rights and the level of operation of the users were discussed. In 

addition to that we have learnt how to create new users and link them to groups. Now 

we will move on to the interesting feature of the security system, where we will discuss 

about granting access rights for the department to the employers. Open the “Records 

will be changed” window by double clicking the employee record in the “Employee” 

table.  

  

➢ Select the “Access” tab from the “Records will be changed” window  

➢ To give access to all the departments and stock rooms the click the [++] sign   

➢ To give access to single department and single stock room,  click  [+] sign. If Areas 

are used and you want to give access to all departments in an Area – then it is 

enough to click on the Area to choose all departments in that Area.   

➢ To remove access to all the departments or to all the stock rooms the [--] is clicked  

➢ To remove access to one department or to one stock room the [-] is clicked  

➢ To deny the user from accessing the department, set his access rights to none.  
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Because a user with limited rights on departments doesn’t see the departments where he 

hasn’t the rights to see them, the program allows the supervisor to open for the user the 

possibility to see all departments and all equipment in 3 windows.  – Tree – all departments 

– and – all equipment. This makes it possible for the supervisor to give the user the 

possibility to see an extra button for each possibility that enables him to see the information 

without changing it. These rights are given in the tab ‘Preferences’.  

  

In Preferences it is possible to choose open window at start up, default rate and workbooks  

that the user uses. Default workbook (red) is used when inserting a new job, except it is 

inserted from workbook, then the workbook is used.    

CUSTOMIZATION  
  

REPORTS  

  

The Reports are the collection of records in a printed format. One can quickly define and 

print a variety of reports, labels directly from the program. A detailed set of wizard dialogs 

let you define the report characteristic (color, size, margins, graphics...), report layout, 

report sections (header, footer.....).  

  

SETTINGS  
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The printer settings are initialized in the “Print Setup” window in order to reflect all the 

userdefined settings in the report. The settings basically covers a wider area like:  

➢ Selection of printer from a list of options or automatically selecting a default printer 

(Name:).  

➢ Selection of paper size (Size:).   

➢ Selection of printer orientation.  

The Printer is either selected from the set of options in the list box or can otherwise select 

the printers placed on 

the network. To select a 

network printer from 

the complete list of 

network printers, click 

the  

  

The paper size and the source is either selected from the list of options in the list box or we 

can click the  tab and define it in there. The “Properties” window assists us in 

defining the properties of the printer paper like  

➢ To choose the quality of paper like source and size.  

➢ To define the layout of the paper of their choice such as portrait, landscape or 

rotated landscape.   

The  tab is clicked to set the printer with all these user defined functionalities. 

Thereafter the printer will be with all these properties enabled for every print request 

placed by the user.  

  

THE PRINT PREVIEW  

The “Print Preview” window gives the preview of the final printout. This plays an important 

role, as the user is allowed to take a quick look over the preview and even allowed to change 

the properties accordingly.   

  tab.  
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The “Print Preview” window has various options such as:  

 =  Full width view  

    =  Full height view  

  =  Zooming of window  

    =  Print this page  

    =  Printing option  

    =  Text file out: REPORT.TXT  

    =  Exit without printing  

    =  Search for..  

    =  Pin to.. (stay after printing)  

  =  Send through Email  

  

  

    

  

We can also make changes to the format by going to (File => Reports)  
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We get the „Define 

Report Output“ window, by clicking the   button we get the „Adjust Invoice Printing“ 

window where we can move the fields about. This window allows us to adjust the location of 

the text the invoice by changing the respective field length.   

The fields that are available in order to adjust the invoice printing are Header, Material code, 

Material name, Quantity, Lines, Unit price, Line total, Totals and the Summaries respectively. 

All the fields are allowed to move for about 40 mm right or Left.  

  

It is not necessary to always preview before printing.    

Although it is recommended so we can check if there is anything that needs to be fixed.  
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If we go to the  „Define Report Output“  window again, we can select a report and click  

.  Here we get to choose if we want  „Preview“: Always, Never or if we want it to Ask 

us every time.  

  

LOGO  

  The Logo of the user or the company can  

also be included in the print report by checking the use logo option in the “Report Setup” 

window.   

This window is accessed by selecting the “change” tab in the “Define Report Output” 

window.   

The “Reports setup” window just enables the logo to be present in the report. In order to 

define the logo, follow the steps given below.   

( File => Reports   =>  Report Setup =>  )   



Maintsoft ehf | Reykjavik Iceland | VAT no. 93140 | All rights reserved 

32    

  

  

INCLUDE A LOGO USING THE SYSTEM CONFIGURATION WINDOW.  

  

  
WE GET THE  „SYSTEM CONFIGURATION“  WINDOW   

  

  
  

CLICK ON THE  BUTTON IN FRONT OF „COMPANY LOGO“ AND FROM THERE PICK A  

PICTURE/LOGO WE WANT TO USE IN PRINTING.  FINALLY CLICK . NEXT TIME WE START 

MAINTX THE LOGO WILL BE ACTIVE.  

  

  
  

    

Emailing Of Reports  
We can send reports and files to customers directly from Maintx.   
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Configuring sender and Recipients Email Address  
➢ Steps to feed the email id for both the senders and the recipient  

Open the Employee window (Others => Employees) or (F8).  

To the right we have the „Phones/Email“  tab.  We fill in the appropriate fields, using the 

 button.   

  

Any number of email ids can be added to each employee.  

➢ Repeat the same for the companies (Others => Companies) or (F7).  

➢ On the right we have the „Contact Information“ tab. These mail ID’s are for the 

recipient fields, as these customers are the one who is going to receive the reports 

mail from the respective employee of the organization.  

  

Steps to emailing the Reports  
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Let us take a demo to email the report, in this case the “currency report” is taken to show 

the demo.  

Open the currency window (Others => Currency).  Click on the (print icon)  and the 

„Select an output“ screen appears allowing us to choose the format in which we like the 

reports to be printed/sent.  

   

  
Report.  

  

  

In the upper-right corner of the print preview report there is a e-mail icon . This icon is 

actually a toggle button, meaning it keeps on toggling/switching between the on/off state.   

  

In this demo   we select   the PDF format   and   c lick    to get the preview of the currency  
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Click once on 

the icon and 

then close the 

report by 

clicking the 

cross  

.   

  

Once clicked, 

an dialog box 

appears asking 

the user to 

select the 

appropriate location to 

save it.  

  

Name the PDF file and  

click   

  

  

  

Now we get the emailing screen.  

  

  

  

Our email appears in the "From:" box.  

  



Maintsoft ehf | Reykjavik Iceland | VAT no. 93140 | All rights reserved 

36    

  

To find the desired recipient of the file, we click   and get the „Select Recipients“ 

window.  

  

  

  

Select a recipient and click .  

  

We do the same if we want to add   

„CC:“ = Carbon Copy or   

„BCC:“ = Blind Carbon Copy.  

Now we can enter a subject, a short messege and click .  

    

Configuring the e-mail  
(File => System configuration)  

To configure the e-mail we go to „System Configuration“ and click  until we get to 

the „E-Mail Configuration“ screen.  

  

We type in the details of the employee/our email ids and information.   
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In the attachment field you get the location of the PDF reports stored automatically.  

  

Sender Domain: Is the name of the mail server or the domain. In Our case, Maintx.com  

SMTP Server: Is the same as Mail server   

SMTP Port: Is the default port number and it is given 80 for this demo  

Sender Address: The Valid Email id of the sender. The same will be present in the From Filed 

while sending the reports.  

Sender Header: Header to be used for the sender.  

Sender Name: The name of the sender. This may not be same as the Email ID, just the name 

in which the sender will be identified.  

Reply To Address: If in case, the recipient wants to contact could respond to the reply 

address. This may be or may not be same as sender Address.  

Reply To Name: The name of the person to be replied.  

Authorization User: The name of the authorized User. The user signed in obviously should 

be authorized one with supervisor level.  

Authorization Password: This is the password to be set for this authorized user.   

  

Likewise for all the application users, the email configuration is set in the update employee 

window (click change button in the employee window) by clicking the emails tab and key in  

the details. For the Customers or the companies, the Email Configuration is set in the update 

companies (click the change button in Companies).    

1 The menu bar  
 

  

  

Now we will look at the drop-down menu. We will start with File and go through all the 

menu items, then we do the same with Maintenance, Spare Parts, Other, Text, Window and 

finally Help.  

The coloured buttons below the menu bar are shortcuts to frequently used windows.  

 Jumps to the Maintenance → My Job window.  

 Jumps to the Maintenance → Overview window.  
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 Jumps to the Maintenance → Workbook window (keystroke: Ctrl – Y).  

 Jumps to the Maintenance → Tasks window (keystroke: Ctrl – R).  

 Jumps to the Maintenance → History window.  

 Jumps to the Spare Parts → Inventory Entry window.  

 Jumps to the Spare Parts → Orders window.  

A click on the  button in the top- right corner will take us to the Maintx website. 

There we can find short tutorials about how to carry out various tasks, and other helpful 

material, as well as information about MaintSoft, the developers of Maintx.  

    

2 File  

 

Let’s begin with the File menu. There we can find various items concerning setting up Maintx 

for use.  

The file menu consists of User, Print Setup…, Reports, Language, Data Tables, System 

Configuration, Export Configuration, Security, Order Procurement, Set Activation Code and  

Exit.  

2.1 User  
(File → User)  

The user menu has two options namely change password and lock screen.  
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2.1.1 Change Password  

The Change Password window allows the 

user to change the password.   

The passwords are obscured on-screen to 

increase security. To make sure the correct 

changes have been made we are asked to 

repeat the new password.  

  

2.1.2 Lock screen  

The “Use Screen Lock” screen, locks the 

window. To return back to the application, 

the user enters his or her password. This 

screen is to ensure privacy when the 

authorized user is not present.  

2.2 Print setup…  
(File → Print Setup...)  

The Print setup window is to define the printer properties in order to get a successful print 

out, out of the default printer. In this window we can select the printer, size of the paper 

and the source from where the paper is fed. To set further options specific to each model of 

printer press the Properties… button.  

  

The orientation of the paper like portrait or landscape can be set by checking the 

appropriate radio buttons. The printer we assign through this window will be taken as a 

default printer throughout the application.  

2.3 Reports  
(File → Reports)  

We can specify the print setup properties of work sheets and reports for each user.   
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(See Pages 25 and 26).  

2.4 Language  
(File → Language)  

To change the language of the user interface see chapter 2.7: System Configuration.  

Opens up the Translation window. Here we can change nearly all text strings in the user 

interface.  

  

For example, looking at the Translations window itself, if we desire to change the word 

labelling the “Query” button that can be done here.  

The window has three columns: Language, Original string and Translation.  

The Language column specifies which database each string belongs to. Original string lists 

the underlying (English) string, and Translation shows the word to be mapped to the 

original.  

An & symbol specifies that the following letter will be underlined in the interface. The 

underlined letter is a shortcut for the item. When, say, the letter Q is underlined on the 

Query-button the key combination alt-q will act as a shortcut for that particular button in 

that particular window.  

There are seven buttons to choose from in the Translations window.  

[Send To] exports or prints the data displayed in the window, similar to the  button.  
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[Select Language] opens up a window where we can choose between different wordlists to 

work on.  

[Query] opens up a window allowing us to make queries.  

[Add Translation] [Change] and [Delete] work on individual strings.  

[X] Closes the window.  

    

2.5 Data Tables  

2.6 System Configuration  
(File → System Configuration)  

The system Configuration is done in several stages.  

  

We start with the General configuration.   

By clicking the  button in front of each line, we can select the path to:  

 The „Database“, „Company Logo“, „Data Export“, „Document Template“, „Document 

Storing“ and „Invoice Background Picture“.  

Select the language from the list box by clicking the arrow.   

Click   

  

Next page is the Inventory Configuration.  

To provide automatic numbering for the inventory and stock count, tick the box in front of 

“Automatic numbering”.  We can decide the number of characters we want for the 

automatic numbering and enter it in the box marked “Characters in numbering”.   
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Here we can enter the wholesale and retail margin percentage in the provided box.  

Select the default currency code from the list box. The currency code selected here will 

appear throughout the application.  

  

If we want Maintx to take care of automatically numbering companies we tick the box at the 

bottom marked „Automatic numbering of companies“. Click   

The Maintenance Configuration screen asks if we want automatic numbering for various 

new fields, such as Department, Equipment, Eq-parts, and Tasks.  

  

  

  

In Mileage Recording the automatic reminder of run record can be done in two ways. The 

system either uses the calendar, adding a day’s run each day that passes or fetches actual 

addition every day from text file.   

Click    
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That text file is made by another application or another computer, which takes care of this 

recording specifically.   

If we want to use such a file we need to tick the “Use file for automatic recording” box.  

  

If we have some mileage that need to be recorded manually, certain number of days will be 

specified.   

To have Maintx remind us when there is time to record the mileage we tick „Automatic 

reminder of mileage recording“  

Click .  

For Maintx to automatically find tasks whose time has come, we have to tick the „Find tasks 

automatically?“ box. If we want to do it manually we leave the box blank.  

  

Here we can instruct Maintx how often it should find the fixed tasks.  

If we select Other, a new box appears. In that box we need to specify with what interval we 

want Maintx to check.  

Click  .   
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This is the Email Configuration form, where we need to provide the email id for the signed in 

user. Information is in turn used whenever the user emails reports.  

  

.Allows us to set the procurement scheme. Either press F5 key or just right 

click the box and it will display the „select procurement scheme“ window.  

  

2.7 Export Configuration  
(File → Export Configuration)  

We can export all data regarding customers or stockrooms by clicking on the   

button at the bottom. We can  (delete) items in the menu 

using the appropriate buttons.  

Click  .   

Click  .         ( See more on Procurement on page 4 0 )   

  ( add),  ( change )   and  

Click  
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2.8 Security  
(File → Security)  

The employee name, login and level of clearance (Operator, Supervisor or No access) can be 

seen in the Browse Users dialog box. We can also see if the employee belongs to a User 

group and/or Work group.  

Information can be ordered by name of users or by their Login name by selecting the 

appropriate tab.  

Only users with the status of supervisor can modify the settings in this window. Users with 

operator status can only view the information and cannot make any changes.  

  

Users can be created, modified or deleted by using the appropriate buttons.  

Please note that Users is not the same concept as Employees, but they are connected 

through the same login.  

New employees are registered in the Other → Employees window (F8).  

By selecting the employee and clicking  (change).  
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The Maintx security menu mainly deals in setting the access rights to the users and to the 

existing employees.   

The access rights depend upon persons to persons, as all the users and the employers 

cannot be given the same permission.   

The access right can only be set by the administrator or the supervisor and not by any 

person below this level.  

Therefor the system security plays an important role and deals in setting the access rights to 

either the users or the employers. The administrator can set the rights only after he gets 

logged in. This is done by entering the login and password in the Maintx screen. Once the 

login id and the password are provided, the authentication or the verification stage starts. At 

this stage, the password entered is verified with the stored password in the database (the 

password provided at the time of registering the application). Once the user is identified to 

be the genuine user, he is credited as a successful logger and allowed to access the 

application.  

Let us have a look at how the administrator sets the access rights for the new users. This is 

done by opening the “Browse users” window by clicking the “Security” menu from “Files”. 

This window allows the administrator to include new user either as individual users or 

grouped users by clicking the “Insert” button. During the insertion process, the level of 

operation and accessing permissions for the new users can be set.   

➢ Supervisor   

➢ Operator   

➢ No access  

With the accessing permissions such as  

➢ No access  

➢ Full access  

For the Supervisor mode of operation, the access permission need not be explicitly 

defined, as the supervisor level is the top most priority with all the accessing rights 

implicitly defined.  
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For the operator mode of operation, the accessing permission should be defined by 

checking the “Initial access” option list.  

For the No access mode of operation, it is self-explanatory that this user is not allowed 

to enjoy the privilege of access rights.  

On the other hand, modification and deletion of the existing users could be done by 

selecting the change and delete buttons.   

A group is created by clicking the “User Groups” button and rights are allocated to the 

group. Individual users attached to the group, thereby they inherit the right of the 

group. However overriding the group rights is always possible for any individual user. 

The authorization for the group can be provided at any one of the following levels 

discussed above  

  

For security reasons, only the supervisor or the administrator should have full access 

rights. The application is embedded with this security system so as to secure the 

information and to hide the information from the unauthorized usage.  
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In order to view access rights allotted to the users for the current working window, the 

shortcut key ctrl F8 is pressed. The ctrl F8 key opens the “Set Access Rights” window. 

One can fix the rights of the fields to either “Yes or No”, by double clicking on the 

respective record. From this window, the “Browse users” window could be called by 

clicking the “Users” button. Thus the “Browse users” window can either be accessed by 

clicking the “Security” menu or can be called from the “Set Access rights” window.   

So far the access rights and the level of operation of the users were discussed. In addition to 

that we have learnt how to create new users and link them to groups. Now we will move on 

to the interesting feature of the security system, where we will discuss about granting access 

rights for the department to the employers. Open the “Records will be changed” window by 

double clicking the employee record in the “Employee” table.  

  

➢ Select the “Access” tab from the “Records will be changed” window  

➢ To give access to all the departments and stock rooms the click the [++] sign   

➢ To give access to single department and single stock room, click [+] sign. If Areas are 

used and you want to give access to all departments in an Area – then it is enough to 

click on the Area to choose all departments in that Area.   

➢ To remove access to all the departments or to all the stock rooms the [--] is clicked  

➢ To remove access to one department or to one stock room the [-] is clicked  

➢ To deny the user from accessing the department, set his access rights to none.  
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Because a user with limited rights on departments doesn’t see the departments where he 

hasn’t the rights to see them, the program allows the supervisor to open for the user the 

possibility to see all departments and all equipment in 3 windows.  – Tree – all departments 

– and – all equipment. This makes it possible for the supervisor to give the user the 

possibility to see an extra button for each possibility that enables him to see the information 

without changing it. These rights are given in the tab ‘Preferences’.  

  

In Preferences it is possible to choose open window at start up, default rate and workbooks  

that the user uses. Default workbook (red) is used when inserting a new job, except it is 

inserted from workbook, then the workbook is used.    
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We can assign access to the employee.  

Supervisor = Has unlimited access.  

Operator = Has only access to what he is given under „Employees“ (F8).   

No access = Closes on any and all access from the employee.  

The user can be added to a „user group“ and then the group given access right (operator or 

supervisor). We do that by clicking the  button.  

In all screens/windows in Maintx we can click CTRL + F8   

  

  

Here we can choose witch actions each employee is allowed to perform on this particular 

page.  

To change Yes to a No and vice versa, we double click the word.  

From this screen we can also access .   

2.9 Order Procurement  
(File → Order Procurement)  

Order Procurement is an important and essential feature of Maintx.   

Once an employee has registered an order, the supervisor (employee or employees on the 

procurement list (see below)) needs to approve the order. The order waits for his approval 

in the „Order Procurement“ tab in „My Jobs“.   

To approve the order the supervisor needs to click  in the bottom left corner of the 

screen. Until he does so the order will not go through.  

The order doesn‘t go through until all those on the procurement list have approved.    

As soon as an employee logs in to Maintx he is automatically logged into the procurement 

system.  

To define which employee/employees need to approve orders we go to (File → Order 

Procurement)  

  and  
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change the name by clicking   

On the right side we can add =  employees to the procurement system  

(employees that need to approve orders) or remove employees with   

If we add more than one name to the employee list, all of them have to approve an order for it 

to go through, not just one.   

  

In order to set the procurement scheme for the signed user, go to (File→System  

Configuration) and click the  button continuously to reach the procurement form as 

the one displayed below.  

  

Now click  and restart Maintx for the changes to take effect.  

  

In the left window, we use the „Default“ scheme (we can add another one by using    or  

Right click the box and select a  “ Scheme ”  from the list. Click    
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2.9.1.1.1.1.1.1 Role of Procurement Scheme  

  

Let’s look at the procurement scheme for our „Mar. “.   

After logging into Maintx,  XX clicks Maintenance – My Job  and picks the „Order 

Procurement“ tab(See Orders p. 69)  

  

All orders waiting approval from XX are found here.   

To have a closer look at the order in its entirety, select and click .  

To approve the order, we select the right order and click   

Let‘s look at „Orders“ in (Spare Parts → Orders)  
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In the box in the upper right corner, we tick „For Procurement“. Now we see all the orders 

that are waiting to be approved. To see witch employee needs to approve the order, we 

click  

the  button.  

  

If there is no one registered in this box Maintx skips the  „For Procurement“  step and goes 

straight to  „Confirmed“.  

    

  

2.10 Set Activation Code  
(File→ Set Activation Code)  

To become a registered user, we go to the “Register Maintx“ window.   

Here we put in information such as Company Name, Serial Number, copies, counter, Level 

and the type of Module (get this information from MaintSoft Ltd.).   

Once all information has been entered, we click .  
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2.11 Exit  
(File → Exit)  

Exit is the last menu in Files menu, as the name indicates this menu is used to exit from the 

application.  

       

3 Maintenance  
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3.1 My Job  
(Maintenance → My Job)   

Here we have all the work/processes belonging to the user that is logged in at any given 

time.  

„My Job“  is divided into 5 different tabs  

  

➢ Tasks  

➢ Diary  

➢ Measurements  

➢ Mileage  

➢ Order Procurement  

  

3.1.1.1.1.1.1 Tasks (tab)  
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In the Tasks tab we have all the tasks the logged in user is responsible for as well as all jobs 

he is registered on.  

We can filter the tasks by choosing All (tasks), Active (tasks), Inactive (tasks), Priority Task or 

Overdue (tasks).  

Active Tasks are green  

Priority Tasks are red  

Inactive Tasks are black (Blue Line)  

When Maintx has awoken a task, but we are yet to print it out, the „code“ number is blue.  

  

 = Adding a new task    

 = Changing a current task      

 = Removing/Deleting a task  

  

3.1.1.1.1.1.2 Diary (tab)  

4  The diary can be used for personal memos, reminders and notes.  
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4.1.1.1.1.1.1 Measurements (tab)  

  

Here we can see all of the manual measurement conditions we need to monitor and record 

(temperature, vibration, pressure ...).   

The measurements can also be automatically lifted on some indicators, but they do not 

appear here.  

In the lower left corner we can select witch measurements we want to look at.  

  

      All = We see all available measurements pertaining to us.  

Due = Meters that are due for a reading (time has come).  

Same Workbook = Meters from everybody with the same workbook.  

  

4.1.1.1.1.1.1.1 Adding Measurements  

  

If the date isn‘t right we rectify that. (remember, 140313 becomes 14.03.2013)  

Log the time, the reading and click .  

We select the  meter from the list on the left and press  
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4.1.1.1.1.1.2 Mileage (tab)  

  

Here we can see all of the usage-meters (temperature, vibration, pressure...).  We select 

what mileage (meters) we want to see by using the filters in the bottom left corner.  

   

The last tab called the “Order procurement” is basically to display the orders that are 

pending for the signatures of the employee who are enlisted in the procurement scheme. 

The orders get signed by pressing the procure button. Once signed, the orders move on to 

the orders window (others menu-> Orders). Later on from there processed button is clicked 

in order to process the order. Once the entire enlisted employee in the scheme has 

processed, the order goes to the Confirmed stage, else if someone is left out still to process 

the order, then it enters into the “For Procurement”. Thus the procuring and processing of 

order works. More about the Procurement scheme and processing about the orders refer to 

pg. no 44.  

  

The tasks for the logged in user is inserted using the Insert button. Start keying in all the 

details for the tasks. The fields such as Task group, Workbook, Workshop and Supervisor  are 

very much essential, without these fields the tasks will not get inserted. Click the apply 

button to insert the triggers, resources, Images and documents for the tasks. It is not 

necessary that all these triggers, resources, images, documents have to be given at the time 

of insertion. Insert them if needed, using the “Apply” button. Else click the Ok button and 

later add them by clicking the change button. Thus the apply button is an option and 

additional feature to add the accessories at the time of insertion and this enhance the users 

to add all the associated accessories to the tasks at the insertion itself.    
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4.2 Tasks  
The “Task” window is to list the tasks of all the employees in the plant. The Tasks initially 

takes one of the form such as    

➢ Active Task  

➢ Inactive Task  

➢ Priority Task  

➢ Overdue Task  

➢ On Inactive (Department, Equipment and Equipment Part) (Clean-up)  

The Records based on the type are filtered and viewed accordingly by clicking the radio 

buttons present in the lower most part of the window. The “Task” window displays record 

such as Task code, Status of Task, Workbook code, Zone code, Department code, Equipment 

code, Equipment part code, Equipment Part Name, Last done, supervisor or the 

administrator who supervise the task, Total Cost needed in order to process the task. 

Column level sorting can be done just by clicking the respective column header.  

  

  

  

The window allows the user to change, insert or delete the data just by clicking the tab in the 

bottom of the horizontal window or even these functions can be handled by the short keys 

such as alt I, alt c, alt d for insert, change and delete function respectively.  
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4.2.1.1.1.1.1.1 How to insert a task  

  

Before proceeding on to the creation of the task, one needs to know the architecture on 

how the Maintx works. Overall the application functionally segregates the total unit into four 

major units such as Zones, Department, Equipment and the Equipment Parts. Thus in order 

to insert a new task, all these four units has to be present for the tasks to perform on. 

Moreover the zone is nothing but the area or the sector. Under the Zones, we have the 

departments. There may be as many as zones as per the requirement and as many as 

department under them. Same way there may be as many as equipment’s and equipment 

parts running under them. These hierarchy are strictly implemented as to group the 

equipment’s, equipment parts and there by maintaining or running larger number of 

equipment/eq-parts is no way going to be tough anymore and so the maintenance too.   

The steps basically need to perform to insert a task and to perform on them.  

Try inserting a new task by clicking the Insert button. While clicking the insert button, the 

select unit window flashes and click the appropriate hierarchy under which the task needs to 

perform. The new task insertion form looks similar to the one that is displayed below (here 

we clicked on fixed and activate contract to show the whole picture).  

  

  

  

Later on - Just key in the task details such as the task code, task Group, workbook name, 

workshop, and also the supervisor signing the task is vital.  

  

  

To the right side there are five options placed namely   
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➢ Fixed Type  

➢ Malfunction Type  

➢ Organized Type  

➢ Modification Type  

➢ Damaged Type  

  

Let us have a look on these types.  

The ‘Fixed Type’ tasks functions at a fixed interval. Thus as soon as the “Fixed Type” option is 

clicked, the types of intervals such as annually, monthly weekly, daily, mileage options get 

displayed. Therefore a Task of fixed type performs automatically for every specified interval, 

say if the option monthly is clicked and in the interval textbox, 3 are given. Then for every 3 

months the tasks gets activated and starts functioning. Thus a task of fixed type even after 

closing gets recycled back to the task window as inactive tasks with the scheduled or 

estimated resources. There is also a first time option if we make the job within the interval. 

This function can also be used when we postpone a job, then we close the job with the text 

postponed and use the first time option for postponed to.  

By clicking at “link a template document” you can link a template, and then when the job is 

activated, a copy of the template goes to the documents for the job, where you can edit the 

document. By closing the job the edited document goes to the history file. The edited 

document is no longer in documents for the job (ready for the next run).  

The other types of tasks such as Malfunction, Organized, Modification, Damaged are more or 

less the same and they used depend on the context of use in the plant. The Priority for the 

tasks could be set by clicking the Priority Tasks options 0-9, where 1-9 will show red in the 

list box.  

Click Apply button to add additional accessories such as Triggers, Resources, Images and 

Documentation.  

The Triggers are inserted to fire the tasks automatically based on the measurements of its 

equipment that is performing the task. In this window one can set a boundary value and 

conditions. Thus once the measurement value crosses or goes below this boundary value, 

the task gets triggered and start functioning.  
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Click the insert button of this form to insert the trigger and the same window as displayed 

below  

  

  

Select the measurement group either by using right click or press F5 key to get the select 

Measurement Window. Further check or uncheck the “Less than Measurement” option to 

set the conditions either to more than the boundary value or less than the boundary value.  

  

  

  

  

  

  

  

  

  

4.2.1.1.1.1.1.2 Resources for the Tasks  
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The resources tab is clicked in order to provide the tasks with resources. The Resources as on 

the whole is divided into three types.  

  

➢ Labour or the Man Power   

➢ Stocks or items or Materials   

➢ Others category (this includes any other resources other than the labour or stock)  

Thus the essential and needed resources are added to the tasks by clicking the appropriate 

buttons such as Add Material, Add Labour and Add Others respectively.  

Moving on to the next tab namely history. As the name indicates this form gets hold of the 

previous track of the task cycle and displays accordingly. The history holds the records only if 

the task type is fixed and this is empty for other types.  

The next tabs are documents and Images respectively. These are the added feature that 

enhances the task with more particulars. One can attach any number of documents or 

images in correlation with the task. Thus this feature enhances the user to have more 

particulars stored for the tasks.  

    

4.2.1.1.1.2  INACTIVE TASKS:  

All the tasks that are newly inserted will be in inactive stage and the resources added for the 

tasks in the inactive stage are considered to be estimated resources. Thus at inactive stage, 

one can frame an estimated cost in order to complete the tasks. Moreover it is not 

necessary that the cost framed at the inactive stage (termed as Estimated Cost or 

Scheduled) be the same as the cost allotted for the task in the active stage (termed as Actual 

Costs). Thus the Resources allocated at this stage will be displayed in the schedule column of 

the Resources tab  

  

Active Tasks: The Tasks are called as Active Tasks if and if only if they are alive and operating  
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currently. In order to activate the task either clicks the start icon  or double clicks on the 

inactive task and check the Activate option.   

 Once the task is over, it can be defined as “Finished Task” by selecting the icon (right 

symbol). Once the icon is clicked, the “Task Finished” window is accessed as shown below.  

There are three modes of closing this task. They are   

➢ No billing  

➢ Make invoice  

➢ Withdraw to Account  

IF “No Billing” option is checked then the generating of invoice don’t take place, further this 

option is mostly preferred when there is no resources used or if the task is performed for 

internal purposed where the billing is not essential nor required. The window takes the 

closing date and the supervisor in charge of closing as an input.  

  

“Make Invoice” option is selected to generate the invoice. The customer to whom the 

invoice to be printed should be given and also the discount details if applicable. The invoice 

is printed on clicking the Ok button. This invoice print prints the cost details of the resources 

used for the task and once printed, the record will move on to the company’s window 

(others->companies).   

The “Withdraw to account” option is checked if and if the customer is a regular one and he 

maintains an account with the organization. Thus this option enables in gathering all the 

transactions for the particular customer and later on the billing can be had for some monthly 

basis. This basically avoids the need of printing the invoice then and there and bugging them 

with lots of invoices.  

Fixed and scheduled jobs have extra security by closing – you have to enter a number 

indicated in order for the program to continue.  
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   Any number of new document files can be attached to the tasks by clicking the 

insert button of the “Files” window accessed through the document icon present in the 

“Task” window. The attached files through this way can even be modified or deleted using 

the insert and delete button. Even to view the document files assigned to the task, the 

“Files” window is accessed.  

   Any number of new image files can be attached to the tasks by clicking the insert 

button of the “Image” window accessed through the image icon present in the “Task” 

window. The files in the window can even be modified or deleted using the insert and delete 

button. Even to view the image files assigned to the task, the “image” window is accessed.  

   The Print icon is clicked in order to print all the “Active Tasks in Process”. In order to 

have the records of the active tasks in process in a printed format, the print icon is selected. 

This window gives a preview of the report of the tasks in active, if the user wants the report 

to be printed, can go for the print option in the respective window.  

  

The copy icon is clicked in order to copy the task from one department to another. 

This copy task window automatically generates the task code and takes   the zone, 

department and equipment code as an input from the user, moreover these input can either 

be typed or selected from the respective window by pressing F5 key or right click in the 

mouse. Thus the copy task functionality helps the user to copy the task from one 

department to another respectively.  

  To display the tasks only for the particular equipment or the equipment part selected 

in the area list, the area icon is clicked. Thus this “Area” icon when clicked takes to entire list 

of equipment and equipment part grouped for the department and zones. From this list any 

equipment or the equipment part can be selected in order to view their corresponding 

assigned task in the “Task” window.  

  

 The Resources button helps us to view the overall resources used so far for all  

the active tasks. If no input is provided to the form, then it prints the overall cost details, else 

it filters and prints according to the range specified. Either all the resources can be viewed or 

only the labour or only the stocks or the others can be viewed by checking the 

corresponding options.  

   

4.3 Quick Task  

4.4 Workbook  
  

This window is the combination of task window and the workbook details, this window can 

be accessed either by clicking the “Workbook” menu from “Maintenance” menu or clicking 
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workbook tab from “Tasks” window. Thus the tasks are viewed based on the grouped 

workbook. There are two print requests, the “Work Request” button probably prints 

according to the request set by the user and the “Overview” tab gives the complete 

overview of all the tasks in process.   

  

The lower window is to display the description for the highlighted task. All the columns in 

the workbook window are sorted when the respective column is pressed. There are two sets 

of insert, change and delete buttons placed, one for the workbook window and other for the 

Task window.   

Users can have many workbooks. Supervisor sees always all. When you insert a new job here 

– the workbook in use is default.  

  Once the task is over, it can be defined as “Finished Task” by selecting the icon (right 

symbol). Once the icon is clicked, the “Task Finished” window is accessed. The window takes 

the closing date and the supervisor in charge of closing as an input.  

  To print a particular task, then highlight the task and click the “Print request” icon. 

This would take you to the “Print request for work task X” window, which takes the start 

date as the input and prints the same request.  

4.5 Task Groups  
  

This window encloses the list of task groups with their assigned codes. This window 

maintains the user lists alone, so it can be called by the “Task” window to assign tasks 

accordingly.  
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The lower window is to view the description for the highlighted employee. The task groups 

can be inserted, changed and deleted by using the appropriate button located at the lower 

most part of the window.  

In the chosen Task group you can see all related jobs.  

     

4.6 Scheduled Tasks   
The tasks can be scheduled here. The Purpose of this window is just to know the details of 

the tasks running under the supervisions of all the users in the plant. Thus the tasks that are 

active and the employee responsible for these tasks and also the resources utilized in 

performing the tasks are all viewed in this window. Mention the zones range, department 

range and the equipment’s range in order to filter them and view accordingly, else give null 

input in order to view all the active tasks.  Just key in the ranges for zone, departments, 
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equipment and equipment parts for which the task is to be scheduled. Click the insert 

button and key in the data’s. Thus any number of tasks that comes between the specified 

ranges is grouped and given the name. The window helps us to plan the tasks since it gives 

complete knowledge about the tasks running all over the plant. The “Resources” button is to 

view the resources allocated for the scheduled tasks. The “Print” icon is clicked to have a 

print report of the scheduled tasks.   

       

Double click the record to get this window as shown below. Press the schedule button to 

schedule the tasks. The tasks tab shows the tasks involved for the given range during the 

insertion. The resources tab displays the resources such as stock, labour and the other items 

involved for these active tasks in the specified range.  
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4.7 Hours Registration  

  

Hour’s registration menu has two classifications namely View remarks and print status  

4.7.1 View Remarks  

View Remarks menu is only an output window to define the remarks. On accessing the 

window, opens up “Error and Remarks” window, which displays error message or remarks in 

correlation to the mileage. When the user tries to enter any unvalued record or any 

mismatch occurs in the equipment run, the error message is automatically updated in this 

window. The error message includes the date and time of creation. The window also allows 

the user to delete a single error record or the total error record.  
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4.7.2 Print Status List  

The “Print status List” window is accessed by clicking the “Print status List” menu. The user 

can print the current status of the mileage of the equipment’s recorded by  

➢ Click the print icon in the “Print Status List” with null fields entered  

➢ Enter the data in the fields to get the selected status list of the equipment run 

printed  

                                              

         

    

4.7.2.1.1.1.1.1 Mileage Recording    

  

Mileage recording window can be accessed in the different ways:  

➢ Click “Mileage” tab in “My Job” Window.   - Normal  

➢ Click “Mileage” tab in “Overview” window.    – old registration and change  

➢ Click “Mileage” menu in “Orders” menu.      – old registration and change  

➢ Click the Mileage icon in “Equipment’s” window.  – old registration and change  

➢ Click the Mileage icon in “Equipment parts” window.  – old registration and change  

➢   

The mileage is the measure of the run of the equipment or the equipment part, so it is an 

important term that has to be taken care in a preventive maintenance system. A new 

mileage record can be inserted to any equipment or the equipment parts by clicking the 

insert tab in the mileage window. The insertion window takes the input such as  

➢ Type of Run  

                              Days  

            Hours  

            Miles   
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     Ton  

              Litre   

      Kilometre  

       Tours      

➢ Type of Recording  

            Automatic  

            Manual  

If the Type of Run is days, then the days like Monday, Tuesday… has to be checked. For the 

remaining Types of Run the addition type and the number of days has to be entered.   

If the Type of recording is automatic, then the system itself will automatically update the 

mileage of the equipment. The system will record based on the type of run selected. If the 

type of run is for all the seven days, then the system will continuously record the run of the 

equipment and update the meter reading continuously.  

If the type of recording is manual, then each and every time the user has to update the 

meter reading manually. This updating of meter reading is done by clicking the mileage in 

my jobs.  Once the mileage window is opened by this method select meter and insert new 

reading for the meter and enter register group (see next page).  

   

On comparing both the types of recording, the automatic recording is much preferred over 

the manual type of recording, as humans are committed to do errors. However in some 

circumstances the manual type of recording is used.  

The window for mileage reading is a part of my job.  

If the mileage for any equipment or equipment part is viewed, we can note three fields 

namely  

➢ Meter Reading  

➢ Addition Reading  

➢ Total Meter Reading  
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Meter reading is the reading read from the equipment or the equipment part.  

Addition reading is the reading, which the equipment or the equipment parts has crossed.  

The Total meter reading is the cumulative addition of the “Addition reading”.  

This is how the total meter reading is calculated.  If suppose the meter is changed and a new 

meter is replaced, then the old meter reading will be displayed in the old meter column and 

the new meter will start counting from zero.  

4.8 History  
The “Maintenance log” window is accessed by clicking the “History” menu. The maintenance 

log window maintains the total record of the task such as Task, Workbook, Zone, 

department, Equipment, equipment part, name of the equipment, Finished Date, Type, 

Mileage and Total cost. The Maintenance log window is basically present to display the log 

sheet of the tasks status regarding their start and finished date. This window doesn’t take 

any data from the user and it is displayed in a read only format. This window gets updated 

automatically from the “Task” window, once the task record in the “Task” window is marked 

as “Finished task”. The lower most part of the window is an additional space provided in 

order to provide the user with the description about the task.  The “Description” window 

can alone be modified or changed by the user by clicking the Description tab of the View 

icon.   

The records in the “Maintenance log” window can be filtered and viewed on the basis of 

Workbook code, workshop code and the signer or the administrator by entering the data in 

the respective fields.   

   
The View icon opens the “Task Maintenance log” in order to view only the highlighted record 

in the “Maintenance Log” window in read only format.   

The Window that is accessed through “Task” tab is to displays the records about the task 

such as the task code, the Zone code, Department code, Equipment code, Equipment Part 

code.  The start and finish date, the work book assigned to the task, the supervisor in charge 

of closing. The records in the window are presented in a read only format, as no inputs is 

encouraged from the user.  
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The Window accessed through the “Description” tab is to displays the description for the 

highlighted record in the maintenance log window. The text in this window can be updated 

accordingly, as this window allows the user to modify the data.  

We can have printouts from history with clicking the print-icon.  

  

Here we can filter out information.  

Billing Code will filter out the Departments with same billing code.  

4.9 Cost Items  
Cost items menu displays “Limit overview of stocks Usage and Work” window. This window 

displays the cost details for   

➢ All the tasks in process  

➢ Stocks allotted for each task  

➢ The work assigned  

The appropriate data should be entered in the text boxes such as time period, material 

number, employee, work book and the grouped equipment’s, in order to view the cost 

details only for that particular record.   
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If no input is provided to the form, then it prints the overall cost details of the finished tasks, 

else it filters and prints according to the range specified. Either all the resources used for the 

finished tasks can be viewed or only the labour or only the stocks or the others can be 

viewed by checking the corresponding options displayed in the top.  
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4.10 Plan codes  

4.11 Overview  

 

The “Overview” window displays all the parameter related to the equipment’s under a single 

roof. The window has two parts. The left window consists of the structure namely the area, 

department, equipment and the equipment parts. The right most windows consists of seven 

different tabs namely  

➢ Tasks ➢ Stock  

➢ Measurement  
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➢ History  

➢ Mileage  

➢ Images  

➢ Documents  

 By selecting the equipment’s or the equipment parts in the left most window, then the 

corresponding tasks, stock, measurement, history, mileage, images and documents can be 

viewed in the left window. Any updating like insert, change or delete can be done by using 

the appropriate buttons. Thus this window facilitates the user to view the entire properties 

of the equipment. One can also find easily the equipment’s or the equipment parts that are 

not associated with any tasks. Detecting such equipment’s will help us to use it efficiently for 

some other tasks.  

4.12 Zone  

  

As the Preventive maintenance system is basically grouped into four levels. The Area or the 

zones is the major level, under the zones, the department, equipment and the equipment is 

placed. Thus The Zone menu displays the entire list of area used in the application. An area 

or zone can have as many as departments and the department in turn has as many as 

equipment’s and equipment parts. This window acts as a database that stores all the 

information about the zones and this window is called by other windows in order to select 

the area. The updating like insert, change or delete can be done by clicking the appropriate 

buttons. From this window, one can view the departments, equipment’s and equipment 

parts in related to the zone by clicking the respective tabs.  
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The zones are inserted using the Insert button. Start keying in all the details for the zones. 

The fields such as Zone code and the Zone names are very much essential, without these 

fields the zones will not get inserted. Click the apply button to insert the Departments, 

Images and documents for the tasks. It is not necessary that all these Departments, Images 

and documents for the tasks has to be given at the time of insertion. Use the “Apply” 

button” to insert all the accessories at the time of insertion. Else click the Ok button and 

later add them by clicking the change button. Thus the apply button is an option and 

additional feature to add the accessories at the time of insertion and this enhance the users 

to add all the associated accessories to the tasks at the insertion itself.    

4.13 Departments  
The department window can either be accessed by clicking the “Department” menu or by 

clicking the “Department” tab in “Zones” menu. This window lists the entire departments 

present under the zone. Further to know the equipment, tasks, maintenance log, 

employees, document file, image file associated with the department, the respective 

buttons or icons are clicked. The Departments can be updated or modified or deleted by 

clicking the appropriate buttons.   

  
there should be a minimum requirement of at least a zone as because it is designed such a 

way that the department are placed under the zones and the equipment, equipment parts 

are placed under the departments. Start keying in all the details for the Departments. The 

fields such as Department code and the Department names are very much essential, without 

these fields the department will not get inserted. Click the apply button to insert the 

Employee and phone details, tasks, Images and documents for the department. Use the 

“Apply” button” to insert all the accessories at the time of insertion. Else click the Ok button 

and later add them by clicking the change button.   

  

4.14 Equipment  
The equipment window is accessed in many ways like  

T he Departments are inserted using the    button. For the Departments to get inserted  
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➢ Click the equipment tab in “Zones” window ➢ Click the 

“Equipment” tab in “Department” window.  

➢ Click the “Equipment” menu.  

The “Equipment’s” window shows the entire lists of equipment’s along with the respective 

departments and zone record.   

“Task” button is clicked to view the tasks related to the selected equipment.  

“Materials” button is to view the available spare parts for the equipment  

 The measurement icon is clicked to view the measurement or the performance report 

of the equipment.  

 The Maintenance icon is clicked to view the maintenance log sheet or the history of the 

equipment.  

  

   The copy icon is clicked in order to copy the equipment from one department to 

another. This window takes the zone, department and equipment code as an input from the 

user, moreover these input can either be typed or selected from the respective window by 

pressing F5 key or right click in the mouse. Thus the copy equipment functionality helps the 

user to copy the task from one department to another respectively.  

  The move icon moves the equipment from one department to the other. Once moved 

action is taken, then the same equipment will be found in moved location and no trace in its 

source location. Thus the move action is completely different from the copy action, as the 

copy action only copies, i.e. the equipment will be available in both the location.  

The equipment run icon displays the mileage record for the equipment. One can 

view or insert new meter reading for the equipment in this window.  
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 The document icon is to view the documents linked to the equipment.  

 The image icon is to view the image files linked to the equipment.  

The Equipment’s are inserted using the  button.  For the Equipment’s to get 

inserted there should be a minimum requirement of at least a zone and department as 

because it is designed such a way that the Equipment’s are placed under the zones and 

departments. Start keying in all the details for the Equipment’s. The fields such as 

Equipment’s code, Equipment name and mileage are very much essential, without these 

fields the Equipment’s will not get inserted.  Click the apply button to insert the Equipment 

Parts, Tasks, Materials, Measurements, Images and documents for the equipment’s. Use the 

“Apply” button” to insert all the accessories at the time of insertion. Else click the Ok button 

and later add them by clicking the change button.   

  

4.15 Eq-Parts  
The “Equipment Parts” window shows the entire lists of equipment parts along with the 

respective equipment’s, departments and zone record.   

“Task” button is clicked to view the tasks related to the selected equipment parts. 

“Materials” button is to view the available spare parts for the equipment parts  
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 The measurement icon is clicked to view the measurement or the performance report 

of the equipment parts.  

 The Maintenance icon is clicked to view the maintenance log sheet or the history of 

the equipment parts.  

The copy icon is clicked in order to copy the equipment part from one department to 

another. This window takes the zone, department, equipment and equipment part code as 

an input from the user, moreover these input can either be typed or selected from the 

respective window by pressing F5 key or right click in the mouse. Thus the copy equipment 

functionality helps the user to copy the task from one department to another respectively.  

  The move icon moves the equipment part from one department to the other. Once 

moved action is taken, then the same equipment part will be found in moved location and 

no trace in its source location. Thus the move action is completely different from the copy 

action, as the copy action only copies, i.e. the equipment part will be available in both the 

location.  

The equipment run icon displays the mileage record for the equipment part. One can 

view or insert new meter reading for the equipment part in this window.  

 The document icon is to view the documents linked to the equipment part.  

 The image icon is to view the image files linked to the equipment part  

  

The Equipment Parts are inserted using the Insert button. For the Equipment Parts to get 

inserted there should be an minimum requirement of at least a zone, department and 

equipment as because it is designed such a way that the Equipment Parts are placed under 

the zones, departments and the Equipment. Start keying in all the details for the Equipment 

Parts. The fields such as Equipment Parts code, Equipment Parts name are very much 

essential, without these fields the Equipment will not get inserted. Click the apply button to 

insert the Tasks, Materials, Measurements, Images and documents for the Equipment Parts. 

Use the “Apply” button” to insert all the accessories at the time of insertion. Else click the Ok 

button and later add them by clicking the change button.  

    

5 Spare Parts  
 

5.1 Inventory Entry  
The “Inventory” window is accessed by clicking the “Inventory Entry” menu. The window 

displays the total list of all the spare parts present with their quantity and the price. The 
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lower window displays the location, supplier’s information and the ordering list for the 

selected spare parts in the upper slot.   

  

The user can fix up the quantity of stocks in the stock room by clicking   in the upper slot or 

“Take Stock” button in the lower slot.  To remove the stocks from the inventory list  

  is clicked.  

Code is yellow if the item is on order. Qty. is yellow if Qty. is below limit.   

 The copy icon is clicked in order to duplicate the stock record with some new 

stockroom code. Thus it copies the entire stocks record from one stock room to other with a 

different stockroom code.  

 The move icon moves the stock from one stock room to other stock room. Once 

moved action is taken, then the same stock will be found in moved stock room location and 

no trace in its source location. Thus the move action is completely different from the copy 

action, as the copy action only copies, i.e. the stocks will be available in both the location 

with different stock room code.  

This icon is to view the documents linked to the inventory.  

  

 To assign the stocks to the group  

➢ Click the insert button or double click on the record to access “Register material” 

window.  

➢ Click the ADD button in the Stock table.   
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➢ Select the respective groups for your stocks from the “Stock group” window.  

➢ Click Ok button to complete the process.  

➢   

5.1.1.1.1.1  TO ASSIGN THE STOCKS TO THE MARGINAL GROUP  

  

➢ Click the insert button or double click on the record to access “Register material” 

window.  

➢ Select the marginal group in the text box provided for the field “Margin”.  

➢ Click OK button to complete the process.  

➢   

5.1.1.1.1.2  TO ASSIGN VAT GROUP TO THE STOCKS  

  

➢ Click the insert button or double click on the record to access “Register material” 

window.  

➢ Select the Vat group in the text box provided for the field “VAT Level”.   

➢ Click OK button to complete the process.µ  

   

   

    

  

  

  

  

  

  

5.2 Stockrooms  
The “Stockroom” window displays the overview of the total stockrooms with their Code, 

Name and Location.  
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This window acts as a storage element to store the entire stockrooms present. To view the 

stock present in the stockroom, the “Stock” tab is clicked.  

To view the movements log sheet linked with the stock room, the “Movement” tab is clicked 

or the shortcut key (alt m) is pressed.To have a printed report of the stockroom, the “Print” 

icon  is clicked.  

The cross icon is selected to close the window.  

5.2.1.1.1.1 HOW TO REGISTER A NEW STOCKROOM  

  

We start by going to (Spare Parts → Stockroom)  

We get a window with a list of all available stockrooms (if any exist).  
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Register Name, Place (location), to get a list of all employees to find the right supervisor for 

the stockroom we right click the box marked „Supervisor“. A list pops up and we select a  

supervisor and finally we click .  

  

To add a new stockroom we click    
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5.3 List of Movements  
The “List of Movements” menu is clicked to open the “Movements” window. This window 

gives the list of movements with Inventory Code, Name, Date, Stockroom, Movements type, 

Quantity, Unit Price, Discount and Description.  

  

  

The “Movements” window is only an output window, which automatically gets updated 

from the inventory window, whenever the Receive or Withdraw action takes place. Thus for 

the receive action, the movement will be declared as IN, and for the withdraw action the 

movement will be OUT. As mentioned earlier, the list of movements can be viewed with the 

date, the stock room details from which the stocks are received or withdrawn, the quantity 

of stocks and the price allotted.   

The print icon is to filter and print the list of the movements involved in the stockrooms.  
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5.4 Orders  
  

The “orders” window is to place the orders if there is any need for stocks either for the sake 

of customers or for the internal purposes. The orders can also be placed even from the 

“Inventory” window (spare parts ->Inventory Entry).  While ordering for any items, the 

factors mainly considered are   

➢ Lists of stocks ordered  

➢ Ordered to which supplier  

➢ Quantity of ordered stocks  

➢ Quantity and price of delivered stocks.  

  

  

 The Orders are broadly classified under different types namely  

➢ Draft  

➢ For Procurement  

➢ Confirmed  

➢ Outstanding  

➢ Partly Delivered  

➢ Delivered  

➢ Cancelled  
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Any orders placed will be there in the draft section of the orders table. Later when processed 

it enter into the confirmed stage. From there if the order is completely processed that is if 

the total quantity ordered is been delivered then it enter to the “Delivered” section. If 

partially delivered it enters to the “Partly Delivered” section.  If not at all delivered then 

enters to the “Outstanding” section. If any cancellation of orders takes place at any of these 

three sections, then the orders goes to the “cancellation” section. The “For Procurement” 

section is more discussed in the Order procurement paragraph (pg. no 46).  

5.5 Materials on Order  

   

The “Materials On order window” just display the current status of the materials ordered. 

This window displays the information about the current status of the materials ordered like 

how much materials ordered and how many have not delivered yet along with their order 

number and the type of the order. No modification as such is allowed in this window, the 

changes regarding the ordered materials done in the “Orders” window gets reflected in this 

window. The print icon is to get the hard copy of the status of the materials that is been 

ordered.  

5.6 Materials Below Limit  
This window is to print the materials under limit. It plays an important role as it stores up the 

list of the stocks under limit. In the inventory window, during the insertion of stocks, the 

limit of stocks in hand is also given. Thus once the quantity of the stock goes below the 

boundary level then that is the limit, then these materials have to be ordered immediately. 

Thus this window is very much helpful as it print all these information in just a click of the 

print button. If no inputs are given then it prints the complete lists of material that are under 

limit else the print is performed on the basis of the range specified.   
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5.7 Inventory  
The “Inventory” menu when clicked opens up the “Stock Count” window.  As the name of 

the window indicates, it is to display the entire stocks present in the stock rooms. If you 

submit a print request with null fields entered, then it prints all the stocks listed in the entire 

stockroom.  If you want to know the list of selected stocks present in a selected stock room, 

then place the values accordingly in the appropriate fields.  In the screen below, from and to 

material number is entered and the lists of materials with their stockroom, quantity can be 

viewed in the print preview.   
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5.8 Cost Increase  

6 Other  
 

6.1 Employees  
The Employee window lists the complete record of all employees in the organization. The 

window consists of records such as First names, Surnames, Phones/email and Fields. The 

user can view the records in a sorted manner just by clicking on the respective tabs.  
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The Radio button such as Current, Former and all when checked allow the user to traverse 

the records between existing, former and all employees.  

The insertion of new records, modification of the existing records and deletion is done by 

selecting the respective tabs  

  The copy icon is to copy the data from one employee to other employee. The data 

remains in both the location after the copy action.  

  The move icon moves the data from one employee to the other. This action is 

different from the copy action, as the move action moves the data to the destination, 

hereafter no data will be present in the source location.  

  The file icon is clicked to view the files linked to the employee.  

The User can go for the printed copy of the employee list by clicking the print icon.  

  

   

6.1.1.1.1.1.1.1 How to Insert Employee  

  

Click the insert button or use alt I short keys to insert a new employee. The insertion form 

for an employee looks like as displayed below  
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Type in the data of the employee in the general tab, the application user option will be 

visible only if the logged in user is in supervisor mode, else for the users in lower level will 

not have the privilege to insert an employee as an application user. Thus in order to insert 

an employee with application user privilege, the administrator with supervisor level should 

sign in. Once the application user is checked, the preference tab is made visible and one can 

set the preferences for the employee.  

The preference tab look as shown below, in this form the user is given the right to choose 

the features such as  
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➢ Login name  

➢ Rate  

➢ Workbook  

➢ Lines of Invoices  

➢ My jobs on start up  

➢ Wallpaper  

➢ Number presentation  

  

Login name: The new employee can have the login names as per the own choice, but the 

duplicated login is restricted that is no two employee can have the same login name.  

  

Rate and workbook: The employee can select a default rate and workbook. This default rate 

and workbook will be carried on, wherever the same employee is used. Users can have many 

workbooks – Supervisor sees all.  

  

Lines of Invoices: This is an added feature in this version and plays a sensitive role as 

because by specifying the lines of invoices, one can restrict the invoice from being bugged 

with lots of resources being printed on the same page. Instead if the lines of the invoice 

being specified say it is 3 then the invoice gets split into 3 invoices grouped on the basis of 

Vat rate of the resources and very neatly presented. This feature to the great extent avoids 

the conflicts occurring in the invoice due to overfilling the invoices with lots of printed lines 

and details.  

My Jobs on Start-up: This option when checked favours the user with “My job” window as 

soon as the user gets signed in. This option even plays a vital role as because once the option 

is checked. For every time the user logged in will be forced to check his “my job” window 

and therefore this option avoids from not checking the tasks of the logged in user.  

Wall paper: This option enhances the user to choose their own wallpaper. Just browse 

through the drive to select a wonderful wallpaper of your choice and re log. This will then 

embeds the selected wall paper to the application.  

  

Number Presentation: This is actually the separator used in digits, say for a five digit 

number, we can use comma or dots to separate them into thousands, tens and ones. Thus 

one can select their own separator for the numeric digits. The application will get tuned to 

this number representation for the respective employee.  

  

The “Remarks” tab is to hold the remarks of the employee.  This is very much helpful for 

further reference about the reference or also about the records needed for the employee.  
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Click the “Apply” button to have more accessories such as fields and rates, Tasks, 

Documents and the Email tabs.  

The “Fields and Rates” tab helps to insert the rates for the employee. Click the place button 

on the left panel to insert the fields and click the place button on the right panel to place the 

equivalent rates for the selected field. Thus an employee can have as many as fields and 

rates .  If the employee inserted is an application user, then the default rate can be given in 

the preference tab in order to facilitate the employee with an default rate.  

The “Tasks” tab displays the associated tasks for the employee.  This form will be empty as 

long as the employee is not used by any tasks. These forms get filled only when the 

employee is used by any tasks in the plant. Thus the task tab in the employee updates 

window enables the employee to have a glance about the task details in which they are 

associated.  

The “Documents” tab as like in all the other windows help the users to attach some 

documents.  

The last tab is the “Email”.  This is also an added feature of this version. Introduction and 

concept about this emailing is already been discussed.  Refer to earlier paragraph to know 

more about this. Click on to the Email tab to get the window as like the one displayed below.  

  

  

Here are the e-mail details for the employee. If this screen is left blank, the e-mailing will use 

the e-mail in system configuration.  

Type in all of the details for e-mailing, give the valid mailing details, since mailing of reports 

will take only these mailing details. Once every detail for the employee is furnished, click ok 

to insert the employee. The Apply button allows the user to enter all the details in a one 

click during the new insertion process itself. Ok button without clicking Apply button will 

help you to insert the employee with only general details and the remarks. Later on to add 
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the other details like fields and rates, Documents and email details, double click on the 

record and key in the other data.  

    

6.2 Fields of Work  
The “Employees Field” window is either accessed by clicking the “Fields of work” menu or by 

clicking the “Rates” tab in the “Employees” window. The window displays the employee list 

in the right half of the window for the selected fields of work in the left half of the window. 

One can include as many as employee for the fields of work by clicking the “Place” tab. The 

employees can be removed or deleted from the list by clicking the “Take From” button.  

  

The work fields can be inserted, changed or deleted by clicking the appropriate buttons.  

  

6.3 Rates  
  

6.4 Companies  
  

The left half of the “Company” window is to show the list of suppliers for the organization.  

The right half of the window has three tabs namely  

➢ Telephone and contacts  

➢ Withdrawals   

➢ Invoices  
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The “Telephone and Contacts” tab is clicked to view the contact information of the 

important personalities in the company. This window stores the contact information of the 

important person in the company such as Phones/email, the contact person name and the 

remarks as such. The contact information can be inserted, modified and deleted by clicking 

the appropriate buttons.   

  

  

  

Maintx has been designed with the needs of most users in mind. In many cases, the existing 

data entry fields will suffice to record the information you need. Thus the field here such as 

Telephone/email and contact information mainly designed to facilitate the user with 

additional information wherever required.  

The “Withdrawals” tab is clicked to view the list of withdrawals recently made. The 

withdrawal list automatically gets updated from the “Orders” window, whenever withdrawal 

of stocks takes place.   

The “Invoices” tab is to view the invoices made with the company. The invoice automatically 

gets updated from the “Inventory” window.   

The “Stock” button is to view the stocks present under the company or the suppliers.   
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6.5 Company Groups  
The “Company Groups” window groups up the companies under a group code. A new group 

can be formed by selecting the insert button. To the created group, the companies are 

added by clicking the “Place” button. The “Take from” button is clicked to remove the 

companies present under the group. To delete a group, the “Delete” button is clicked. To 

modify the group, the “Change” button is clicked. The print icon is clicked to print the 

reports of the company groups.   

  

  

  

  

    

6.6 Invoices  
  

The “Invoice” menu is clicked to access the “Overview of Invoices” window. This Window 

does not take any inputs from the user, but it gets updated automatically from the 

“Company” window when the credit button is clicked.    
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The invoice is again an important and essential feature in the organization irrespective of 

whether the plant is small or big, as an invoice is very much needed to bill the customers and 

also to maintain the account of the plant.   

  

This window just displays all kinds of invoices that is been generated either it may be for the 

customers or for companies or for the internal purpose.  

  

To the right side of the window is the “View” panel. Click the options accordingly to view the 

invoices on monthly basis or on the days.    

  

To view the invoices filtered on basis of customers, then click “Select Customers” button.  

  

Use the Print Icon to get the hard copy of the invoices.  

  

  

    

6.7 Documents  
  

The “File links” window is accessed by clicking the “Documents” menu.  Through this 

window, we can view the files linked to the field such as Zone, Department, Equipment, 

EqPart, Employees, Task description, Articles, Task and Suppliers.  

The files linked to the various fields listed above can be changed or deleted by selecting the 

respective tabs. Any number of new files to the fields can also be inserted by clicking the 

“Insert” button. The “File links” window displays the entire path of the inserted file.   
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6.8 Images  
  

The “Image” menu is same as that of the “Document” menu, the only difference is using the 

image menu, the user is allowed to insert any number of image files.  

  

    

6.9 Unit Classification  
The Unit classification when clicked opens “Groups equipment and Eq-Parts” window.     

This window allows the user to create groups and later on the equipment’s or the 

equipment’s parts are assigned to the group. The assigning of equipment and equipment 

parts to the group cannot be done by using this window. The grouping is done only through 

Equipment and Equipment parts window.  There is an option called grouping and by 

selecting that option the user is allowed to select their groups. Thus the “Group equipment’s 

and Eq-Parts” window is called internally by both the equipment and equipment parts 

window in order to select the groups for the equipment’s and equipment parts. The right 

part of the window is to enter the description for the group.   

To view the contents of the file the view icon   is selected.    
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There is a filter tab, on selecting the tab, the user can filter the record and view them 

according to the options checked. The options are  

➢ Department  

➢ Equipment  

➢ Equipment Part  

➢ All  

Using the Filter Criteria window you can isolate the unwanted records from the one you wish 

to display.   

In the same way Reports can either be printed for all the classifications or for the limited 

fields.  

➢ To print the entire records, make sure none of the items in the option list of the 

“Print Classification” window is unchecked.            

➢ To Restrict the reports with specified fields, check the classification you like to 

include  

  

6.10 Mileage  
The “Mileage Recording” window is to record the equipment run. The recording can be 

done either manually or automatically for any period of time. More about the mileage 

recording is discussed in the Para “Mileage”.   
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6.11 Measurements  
The “Measurements” window can be accessed in different ways namely  ➢ 

Click the “Measurements” tab in “My Job” menu.  

➢ Click the “Measurements” tab in “Overview” window.  

➢ Click the “Measurement” icon present in the “Equipment’s” window.  

➢ Click the “Measurement” icon present in the “Equipment Parts” window.  

➢ Click the “Measurements” sub menu present under “Others” menu.  

The “Measurements” window is to keep track of the performance of the equipment and 

equipment parts. Only from this window, one can study the performance of the equipment 

and can make changes accordingly to increase the efficiency of the equipment.   

  
To insert a new measurement for any equipment or equipment parts ➢ 

Click the “Measurement” icon in the respective window.   

➢ Click the insert button   

➢ Enter the name for the measurement group  
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➢ Check the type of measurements from the option list. The options like  

                                                                 

                                                               Temperature  

  Pressure  

  Acidity  

  Oxidation  

  Vibration  

            Sludge  

➢ Select the supervisor from the list box  

➢ Enter the interval period, where the system will automatically update the 

measurement report periodically for the interval mentioned.  

➢ The description field is optional and this space is provided to take any additional 

description for the measurements of the selected equipment.  

➢   

The “Measurements” window records the examination status of the equipment with their 

measurement code, measurement name, measurement type, interval, next date of 

performance, highest and lowest position.  

The measurement code is generated automatically once the insertion action takes place. 

This is the unique code generated by the application to differentiate between other 

measurements records.  

The measurement name is the name for the measurement and this may remain same or 

different. It would be better if a different name were given to the measurements.  

The Measurement type is the type to which the measurements belong. The default types 

that comes with the fresh application is shown below. The user can add more measurement 

types if needed.  

➢ Temperature  

➢ Pressure  

➢ Acidity  

➢ Oxidation  

➢ Vibration  

➢ Sludge  

➢   

The interval is the number of days. If the number of days is 2, then for every 2 days, the 

system will check the position of the equipment and it will create the highest and lowest 

position of the equipment. From this record the performance chart can be studied.  
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Next date of performance is calculated based on the interval specified. The addition of 

interval period with the current date gives the next date of performance.  

  

6.12 Task Descriptions  
  

The “Task description” menu is clicked to access “Standardize Task Description” window. 

This window stores the task description with the description code. The “Document” icon is 

clicked in order to insert any number of files to the description. Records can be inserted, 

changed or deleted by clicking the appropriate buttons. This window is often called 

internally by other window whenever the description files are in need.  

  

  

    

6.13 Material Classification  
  

The “Material classification” window is clicked to access the “Overview of Stock Groups” 

window. This window shows only the groups for the stocks and the user can only insert, 

change or delete stock groups. The “stock” tab is clicked to display the list of stocks assigned 



Maintsoft ehf | Reykjavik Iceland | VAT no. 93140 | All rights reserved 

 

   103  

  

to the group selected. The assigning of stocks to the groups cannot be done using this 

window and to do so, the user has to access the “Inventory” window.  More about the 

assigning of stocks is discussed in Inventory Paragraph (56).   

  

The print icon is selected to print the stock groups and the cross icon is used to close the 

“Overview of stock groups” window.  

  
    

6.14 Margin Classification  
  

The “Marginal Classification” menu opens up the “Margin Groups” window.  This window 

consists of the groups formed for the Marginal rates for the materials. The “Margin groups” 

window consists of the information of the groups such as group code, wholesale rate and 

the retail price. This window is mainly to assign the wholesale and retail price for the stocks. 

Thus the stocks present under the group will automatically takes the retail and wholesale 

price of the group. The user is allowed to view, insert, change and delete the groups by using 
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the appropriate tabs in the window. The Materials assigned to the group can be viewed by 

clicking the “materials” tab. The materials cannot be assigned to the group using this 

window. It is done so by accessing the “Inventory” window. More about this is discussed in 

the “Inventory Entry” Para (56)  

  
    

6.15 VAT Classification  
The Vat Classification window is to fix up the necessary tax for the article. On clicking the 

“Vat Classification” menu, the “VAT” window is accessed. The “VAT” window stores the 

user-defined tax and automatically generated VAT code. The user can view the assigned 

material to this group by clicking the material tab. This window consists of the total 

information about the material such as the material code, Name, new and renovated stocks 

and price list. To assign the materials to the Vat group is done by accessing the “Inventory 

window”. More about this is discussed in Inventory Entry Para (56).   
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6.16 Currencies  
The “Currencies” menu is clicked to access “Currencies and Exchange rate window”. This 

window consists of information about currencies and the exchange rates such as the 

currency code, name, exchange date and the rate. Thus this window is very much helpful in 

foreign business transactions. This window is often called internally by other window to 

select currency.  
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The data can be inserted, changed, deleted by selecting the respective buttons.   

The print icon is to print the preview of the record in the currencies window.   

    

6.17 ZIP Codes  
  

Displays codes for the set of locations, this windows serves as a database and one can insert 

new records or fetch any records from this source, thus avoiding manual typing of codes 

which may lead to unavoidable errors.   
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The records can be sorted out either by postal codes or location. The information is inserted, 

modified or deleted by selecting the respective tabs.  

  

7 Text  
 

7.1 Cut  
This menu is used to cut any description or data in any field. This functionality can also be 

obtained by clicking the cut option from the right click action of the mouse. Even the 
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shortcut keys such as the ctrl key together with x does the same operation “cut “ in text 

menu.  

7.2 Copy  
This menu is used to copy any description or data in any field. This functionality can also be 

obtained by clicking the copy option from the right click action of the mouse. Even the 

shortcut keys such as the ctrl key together with c does the same operation “copy “in text 

menu.   

7.3 Paste  
This menu is used to paste any description or data in any field. This functionality can also be 

obtained by clicking the paste option from the right click action of the mouse. Even by 

shortcut keys such as the ctrl key together with v does the same operation, “copy” to the 

text menu.  

  

8 Window  
 

  

8.1 Cascade  
This menu on selecting helps the user to view any window in the application in cascade 

form. On deactivating this menu, the user is allowed to view the window only in normal 

form such as restored form and maximization form.  

8.2 Tile  
This menu on selecting helps the user to view any window in the application in Tiles form. 

This view is same as the maximization form. The difference between both the views is that if 

the user maximizes the child window, then the child windows title is not visible whereas in 

tiles view, the title of the child window appears. On deactivating this menu, the user is 

allowed to view the window only in normal form such as restored form and maximization 

form.  

8.3 3D View  
This menu on selecting helps the user to view any window in the application in 3D view 

form. On deactivating this menu, the user is allowed to view the window only in normal 

form such as restored form and maximization form.  
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8.4 Tooltips  
This menu on selecting helps the user to view any field in the window with their tool tips. 

Thus helps even the unknown user to know the purpose of any of the field and thus provides 

a user-friendly environment. On deactivating this menu, the tool tips will not be present for 

any of the field in the window throughout the application.  

9 Help  
 

9.1 How to Use Help  
The help window is found by going to the “Help” drop-down menu, there you will find 

information about the software such as “System Information” and a window for searching 

for what you need by typing in the feature or word you are looking for. You can also access 

the help window by pressing F1 on the keyboard.  

9.2 System Information  
The “System Information” window is to get the complete information about the system 

such as when system was loaded, the application path, data path, Computer name, 

Microprocessor used, the used memory, physical memory, Virtual memory, Swap file, 

Operating system, Version, Build no, Remarks, CW version and CW DLL. Thus this window 

facilitates the user with complete knowledge about the system.  

  


